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Boundary Plane Tool

Now you can add boundary planes to exclude some parts of the stone from the optimization.

This can be useful when:

® You see one or several cavities is some area of the stone and want to exclude this area from optimization by cutting it off by plane.
® You need to set the offset of the round cavity with the help of an auxiliary plane (the plane is later deleted).
® Merge back into one facet what was wrongly split by the algorithm into several facets.

The Boundary Plane Tool allows placing the plane which virtually cuts off the part of the semi-polished stone to exclude this part from optimization.



To add a new boundary plane, in the Scene, right-click the model, in the displayed context menu, in the Planes section, select one of the options:

® Plane from points
® Plane from facets



Planes Cavity-mcluzion
Plane from points Instant Cavity (depth = 100 ?m,
Flane from facets Cavity...

Instant Cavity 10 um

Instant Cavity 20 um

Instant Cavity 30 pm

Instant Cavity 30 um

Instant Cawvity 100 pm

Plane from points
A new boundary plane can be plotted via specifying the set of points on the stone surface through which the plane should pass.
When using this option, you need to click the model to specify the points:

® The first click sets the vertical plane normal to the screen

® The second click changes the direction of the plane
® More clicks add additional points and set the plane closest to all the points added



As soon as you set the plane, you may set the offset depth, then apply the changes.

Plane from facets

When using this option, you need to select the facets which will be used to calculate the combined facet (1), then set the offset depth (2), then apply the changes (3).
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Offset Depth

Whether you create a boundary plane from points or from facets, after creating the plane, you can increase on decrease its depth by specifying the offset.

G) You can type in the offset depth directly or use arrows or scroll the mouse button.
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Editing Planes

You can create several boundary planes one by one. Any created plane can be edited or deleted at any moment. To edit the specified planes, in the Scene, right-click the model, in the displayed context menu, in the Planes section, select Edit planes. Select the plane, then edit it by:

® Adding points or facets
® Changing offset depth

To delete the plane, click .

"MyRound | GIA Facetware + MyRound" Appraiser

Changes in Profiles

New Limits for "MyRound_Max" Profile

For the "MyRound_Max" profile of the "MyRound | GIA Facetware + MyRound" appraiser, new intervals for some parameters have been set.

@ "MyRound_Max" profile is a read-only profile with the enlarged intervals for receiving larger Facetware plans.

The intervals for the following parameters have been extended:

® Pavilion Angle
® Crown Height
® Total Height



GIA Facetware + MyRound | Show | GIA Facetware + MyRound | Show

Profile: MyRound_Max (read only) Presets Profile: MyRound_Max ] L]

Cout Symmetry Cut | Symmetry "Cushion” cut is not supported by current appraiser

Parameter [FR [6D [VG6 [EX EX] V6] GD] FR] Parameter Grade Value [FR [GD [VG [EX EX] VG] GD] FR]
Table o 465 485 515 625 665 695 99 Table i} 10 465 495 515 625 665 695 99
CrownAngle i ] 10 21,75 2625 31,25 3875 3875 4025 90 CrownAngle i ] 10 21,75 2625 31,25 3675 3875 4025 90
PavilionAngle O 10 387 397 405 419 &5 431 90 PavilionAngle o 10 387 397@M035 419 425 41 P
Sweetline -9 -6 -3 -1,5 1,5 3 & 9 Sweetline -9 -6 -3 15 15 3 6 9
StarLength e 1 325 375 425 6715 725 TI5 90 StarLength i} 0 325 375 425 615 725 TI5 O
LowerGirdleLength i ] 50 51,5 62,5 67,5 875 92,5 975 99 LowerGirdleLength i ] 50 515 625 675 815 925 9715 9
GirdleBezel i ] (1] 1,25 1,75 225 475 5,75 125 20 GirdleBezel (i ] 0 125 1,75 225 475 575 725 20
GirdleValley T{ 0 o 0 0 075 284 414 614 20 GirdleValley 7). [i] 0 0 0 075 284 414 614 20
CrownHeight i ] 5 105 12 123 17 175 185 40 CrownHeight i ] 5 e 9 ° 10 e 12 17 |B,5° 19 °-w
TotalHeight i ] 10 54 57 58 64,5 66 70 90 TotalHeight i ] 10 54 056 057,5 645 66 o 9%
Culet i ] 0 0 0 0 1 15 2 20 Culet i ] 0 0 0 ] 1 15 2 20
CrownPainting i ] -9 B -35 -32 42 5 7 20 CrownPainting i ] -9 -6 35 32 42 5 7 20
PavilionPainting i ] = 5] -3.5 -3.2 32 4 ] 20 PavilionPainting i ] -9 -5 -35  -32 32 4 6 20
SumPainting i ] -9 -6 5 -4.2 6.2 8 10 20 SumPainting (i ] -9 -6 -5 42 62 8 10 20
GirdleVerticality 20 13 1 1 05 1 13 20 GirdleVerticality 20 -5 | -l = 05 1 1.5 20
HeightGirdleExtraFacet i ] 0 0 0 0 3 4 8 20 HeightGirdleExtraFacet 0 8 20
GirdleCrownExtraFacets 0 0 0 0 0 2 4 20 GirdleCrownExtraFacets 4 20
GirdlePavilionExtraFacets @ (1] 0 0 0 3 4 6 20 GirdlePavilionExtraFacets @ 6 20
GirdleExtraFacets i ] 0 0 0 0 2 4 8 20 GirdleExtraFacets Li ] 8 20

+ Extended boundary
- Narrowed boundary

New Profile - "MyRound_Commercial"

For the "MyRound | GIA Facetware + MyRound" appraiser, the new "MyRound_Commercial" profile has been added. This profile parameter ranges statistically match the brilliants produced by the large manufacturer.



GIA Facetware + MyRound Show GIA Facetware + MyRound

Profie: MyRound_Commerdiall (read only) Presets Profile: MyRound_Commerdiall (read only)
Cut Symmetry Cut Symmetry
Paramneter Grade Value [FR [GD  [VG [EX EX] VG] GD] FR] Paramneter Grade Value EX] VG ] GD] FR]
Table i ] 10 465 495 545 595 665 695 99 Diameter i ] 07 14 28 20
Crownfngle i ] 10 21,75 2625 31,8 366 3875 4025 90 Table i ] 0,85 17 34 20
PavilicnAngle i} 10 387 397 4055 41,75 425 431 a0 CrownAngle i ] 1 1.8 3.6 20
Sweetline =4 -6 -3 -1.5 15 3 6 9 PavilicnAngle i} 0,7 12 24 20
Starl ength (i ] 0 325 375 46 52 725 TI5 90 Starl ength (i ] 35 12 24 48
LowerGirdleLength i ) 50 57,5 625 75 82 925 973 ag LowerGirdleLength i ] 32 g 16 32
GirdleBezel i ] 0 125 175 29 42 575 725 20 GirdleBezel i ] 09 1.8 36 20
GirdleValley Tt i ] 0 0 0 135 24 414 614 20 GirdleBezellocal i ] 03 09 18 20
CrownHeight i ] 5 05 12 126 185 175 185 40 StarAngle i ] 17 5.6 1.2 224
TotalHeight i ] 10 54 57 59 64 66 70 90 UpperGirdlefngle i ] 275 8 16 32
Culet i ] 0 0 0 0 05 15 2 20 LowerGirdlefngle i ] 1.1 26 52 104
CrownPainting i} -4 -6 -3 -1.5 15 5 T 20 Halves\WidthLocal ] 10 15 20
PavilienPainting i} =4 = -3 -1.5 15 4 6 20 CrownHeight i} 1 18 36 20
SumPainting i ] -9 -6 -5 | -25 25 8 m 20 PavilionDepth i ] 1 18 36 20
GirdleVerticality 20 15 -1 -1 05 1 15 20 GirdleValley i ] 1 1.8 36 20
HeightGirdleExtraFacet i} 0 0 0 0 3 4 20 GirdleValleyLocal i ] 03 09 1.8 20
GirdleCrownExtraFacets 0 0 0 0 0 2 4 20 GirdleBone i ] 1.1 1.8 36 20
GirdlePavilionExtraFacets @ 0 0 0 0 3 4 6 20 GirdleBonelocal i} 0,5 09 1.8 20
GirdleExtraFacets i ] 0 ] 0 0 2 4 8 20 GirdleSlopeDeviationhax 3 4 5 32
2RRoundness22 5 i ] 1.1 15 2 20
2RRoundness43 i} 1.3 2 28 20
2RRoundness30 i} 1.3 24 36 20
TableOffset i ] 05 0,8 16 20
CuletOffset i ] 0,5 08 16 20
TableCuletOffset i ] 07 1,2 24 20
TableEdge TEV i ] 2 3 4 20
BezelWidth i ] 22 3 4 20
StarEdge i ] 17 25 4 20
CrownPainting i ] 45 & 8 20
PavilienPainting i ] 43 G 8 20
TableAngle i ] 43 G 8 20
OppositeAzimuth i ] 275 4 8 20
FacetTwistMazx i} 22 3 4 20
JunctionBezelTwistMax i ] 1 2 3 20
OppositeSlopeSumHalf i ] 0,5 1 1,5 20
StarFacetTwist i ] 2 3 4 20
JunctionBoneTwistMax i ] 1 2 ? 20
MainCrownFacetszimuthSymm @ 3 4 ] 20
MainPavilionFacetsAzimuthSymm @ 2 4 6 20
StarFacetsAzimuthSymm i ] 3 4 & 20

Improved Functioning for Larger Mass for VG Grades

Basing on examples from the clients, improvements have been implemented for the “MyRound | GIA Facetware + MyRound”. The implemented changes provide for the appraiser the ability to effectively interact with the complex set of parameters from GIA Facetware that have the VG grade there and as a result, the appraiser
allows finding VG solutions with the larger mass.



» Plans & Scans = Active Appraiser and Pricelist
Appraiser: | MyRaund | GIA Facetware + MyRound
i D ﬂ I D X Compare Standard Report R T T =
# Cutting Price  Mass = llo  Yield Clarity DZ ym- Gr Cut Sym Br | | Pricelst | LEXUS_PRICE_D9MARCH_2012
Shadow scan 1.0533 VG-Poor VG-Poor VG-Poor et sigorthr and damonds or allocatn.
1 [ ® prilant 65186 1.0002  94.94% V51 H VG VG VG-EX Algorithm| 13, Single-M o
7 [ ® Briiant 51485 0.9980  93.99% VS1 H VG VG EX Cutting list arade of 1st diam:
2 W @ Brlent 5006% 0.0799 03.04% VSI H VG VG VG rliant = | B ”
3 [ e Brliant 5044% 0.9727  92.09% VS1 H VG VG VG
4 [ e Brllant 49925 0.9673  91.14% VS1 H VG VG VG W New version
8 [| ® Brliant 49925 0.9666  91.14% VS1 H VG VG VG 11 Old version
5 [l e brilant 48885 0.9432  89.24% V51 H VG VG EX
9 [| ® Brliant 48365 0.9299  88.29% VS1 H VG VG VG
= Plans & Scans Smart Recut
i D ﬂ I D X Compare Standard Report |~
Cutting Price Mass ~ Alloc Yield lrihDZym-  Gr Cut sym B Starting from new version solution
Shadow scan 1.0533 VG-Poor VG-Poor VG-Poor | Starting from old version solution
8 W @ Bilant 67145 1.0348 | SR 97.79% V51 H
22 W @ Blant 67145 1.0341 | SR 97.79% VS1 H VG VG VG
19 | e Brilant 67145 1.0340 | SR 97.79% VS1 H VG VG VG
22 W o Brilent 6714% 1.0333 | SR 97.79% V51 H VG VG VG
11 W e Brilant 67145 1.0332 | SR 97.79% VS1 H VG VG EX
| 13 W e Brilant 67145 1.0327 | SR 97.79% VS1 H VG VG EX
10 W @ eilant 67145 1.0324 | SR 97.79% VS1 H VG VG EX
21 W @ Brilent 6714% 1.0321 SR 97.79% V51 H VG VG VG
25 W @ Bilant 67145 1.0312 | SR 97.79% V51 H VG VG VG
15 W # Brilent 6714% 1.0304 | SR 97.79% V51 H VG VG EX
12 | o Brilent 6714% 1.0294 SR 97.79% V51 H VG VG EX
20 | o bBrilent 6714% 1.0287 | SR 97.79% V51 H VG VG EX-VG
17 W e Brilant 67145 1.0286 | SR 97.79% VS1 H VG VG EX
16 W @ Brilant 6649% 1.0234 | SR 96.84% VS1 H VG VG EX

Smart Recut with "Fix" Options - Remove Facets from Fixing

A new Element Multi Selection Tool can now be used with the "13. SmartRecut (Brilliant, Oval)" algorithm. Using the tool, you can adjust the Fix Girdle, Fix Crown, Fix Pavilion options usage by manual removing the facets from fixing. For example, if under the "13. SmartRecut (Brilliant, Oval)" algorithm, the Fix Girdle option is
selected, it freezes all the facets of the girdle not allowing the algorithm to remove them; then, using the Element Multi Selection Tool you can exclude some facets from this freeze, so that the algorithm will mandatorily remove them from the future solution.

(D A detailed description of using Smart Recut with the Fix Girdle, Fix Crown and Fix Pavilion options is presented on the Smart Recut with restrictions page.

1 The "Remove facets from fixing" selection mode is applicable when all these conditions are met:

® aconvex scan is selected in the list
® the "13. SmartRecut (Brilliant, Oval)" algorithm is selected
® atleast one "fix" option is selected

Ca
To use the tool, in the Recut mode select your convex scan in the list, then select the "13. SmartRecut (Brilliant, Oval)" algorithm, set "Fix" options, and then on the main panel toolbox, click B s Remove facets from fixing. This activates the Element Multi Selection Tool; now in the Scene, you can mark facets to be removed
from fixing.


https://octonus-teams.com/wiki/display/HPODPUB/Smart+Recut+with+restrictions

& Oxygen - [Demolct.oxg]

&S ;
incluzions
Sran Recut  dismonds inpolished Photoreal developer  colors
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~ Plans & Scans

File Edit View Inclusion Window Settings Help
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Run Diamond  Results

] 7] R A X Compare Standard Report |~
Cut Gr Alloc Clarity D: m-C  Mass Br
V] UNK-Poor  UNK-Poor 1.0192
~ Scan Info
Imported model Cutting: -- Model Mass: 1.0192 ct
Price: -- Clarity: --
Discount: - - DZ Calor:
PRC: -- Grade: --
» Inclusions
~ Active Appraiser and Pricelist
Appraiser: | MyRound | GIA Facetware + MyRound -
Profile: Defauft 7 Show Editor
Pricelist: | LEXUS_PRICE_09MARCH_2012 =
Select algorithm and diamonds for allocation.
Algorithm| 13. SmartRecut (Brilliant, Oval) || All presats v
grade of 1stdiam: symmetry:
Allow Girdle Extra Facets EX ~ EX v
M Fix Girdle
CIFix Crown
[ Fix Pavilion
>

R

The Element Multi Selection Tool includes legend available on clicking Show legend.
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Remove facets from fixing

Remove facets by Smart Normalize
Deactivate Element Multi Selection tool

Show legend

13D Mini View
Comparative 13D Mini View
Facetware

Standard Report
My Appraiser
¥ Reports

Polish Report...
Custom Report...
Comparative Report...
Print Label
Export Report Data

Export Model...

+ Model Buiding Info

v Show Model
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Remove facets from fixing

Remowe facets by Smart Normalize

Deactivate Element Multi Selection tool

Show legend N

Laf
13D Mini View
Comparative 13D Mini View
Facetware
O HPOxygen Standard Report

My Appraiser
Smart Recut with Fix Girdle

* Reports
Remove facets from fixing

Polish Report...

Facets you can mark for removal Custom Report...

M Facets marked for removal
Comparative Report...
Facets you cannot mark for removal

Smart Recut (SR) with Fix Girdle solutions HIEELE

may contain all yellow and grey facets. Export Report Data
All red facets will be removed from SR solutions. |

Mark facets on a scan you want to remove ' Export Model...

from SR solutions.

+ Model Buiding Info
Smart Normalize

M Facets marked for removal
Mark facets you want to remove

in Smart Normalize solutions.

For more information on facet marking.
click "Mare info...".

Mare info... | oK

v | Show Model

To view additional information, click More info. This will open a help page in your browser containing some detailed information on functionality.
As you finished with marking facets, on the main panel toolbox, click > Deactivate Element Multi Selection tool. This deactivates the tool.

@ Note that highlighting of current fixing options is only visible in the Scene when the "13. SmartRecut (Brilliant, Oval)" algorithm is selected and fixing options are enabled.

Interface - Configurable Set of Columns in Solution List

The set of displayed columns for the scan/solution list is now configurable: you can select columns to be displayed/hidden and also change their order. The function is available for:

S

Recut

® The mode, the Plans & Scans section.



a

e The  3CaM  mode, the Models section.

@ Notes:

- The configuration for each mode is performed and stored separately.

- The configuration is not available in the Lock to Scan mode.

Allocation solutions x

w Plans & Scans

] | R A X Compare Standard Report |~

# Cutting Irice « Mass It Yield Clario 22 m- Gr Cut Sym Br

I Imported model 1.0192 UNK-Poor UNK-Poor UNK-Poor
1 @ Briliant 5733% C} 0.9858 96.15% VS1 H EX EX EX
2 @ Brillant 5558% G 0.9564 93.21% VS1 H EX EX EX
3 ® Briliant 5324% € 0.9134 89.28% VS1 H EX EX EX
1 ¥
« Scan Info
Imported model Cutting: - - Model Mass: hﬂlgz ct
Price: -- Clarity: --
Discount: - - DZ Color:
PRC: -= Grade: =2
» Inclusions

« Active Appraiser and Pricelist

Appraiser: | MyRound | GIA Facetware + MyRound -
Profile: MyRound_Profilel - Show Editor
Pricelist: LEXUS_PRICE_0OMARCH_2012 -

Select algorithm and diamonds for allocation.

Algorithm|13. Single-M ~
Cutting list grade of 1st diam:
Brilliant 4 EX w

0 customize columns, right-click the name of any column, then in the context menu select/clear checkboxes for your columns. For advanced configuration (several columns at once,
change order), in the context menu, click Details. The Adjust columns dialog is displayed. Here you can select/deselect several columns at once and change their order by drag-and-drop.

In the Adjust columns dialog, you can find 3 separate groups:

1. Core information - you cannot hide or move these columns.

2. Main information - you can hide, reorder is possible only within the group, columns from group "3" will never be able to go before these ones.
3. Other information - you can hide and reorder within the group.


https://octonus-teams.com/wiki/display/HPOD/Interface#Interface-LocktoScan

Colurmns:
¥ | Show/hide model or solution
¥ | # (Model Mame / Solution Mumber) o
¥ Label Color

Cutting
v Clarity Status 9
¥ Price

Model Color x

¥ Mazs (Model Mass)

v Sym (Symmetry Grade)

¥ Alloc (Allocation Algarithm)
Yield

v | Clarity e
¥ D07 (Diamond Colar)

Sym-0 (Optical Syrmetry)
¥ | Gr (Final Grade)
¥ | Cut (Cut Grade)

Er (Brightness metric)

@ Drag & Drop items to rearrange columns

Reset colurmns set to defaults

Also save sorting order

Ok Cancel




@ Note that for the Multiple Diamonds in One Solution mode, the Adjust columns dialog differs: you can customize both solution and diamonds columns.
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File Edit View Inclusion Window Settings Help
2 A . i B2 U S oo®
Scan Recut  diarnands lR%'é‘ﬁi?.’e‘i Photoreal developer  colors  galshad @

Allocation solutions x

~ Plans & Scans

w oW I H R l] I I X | Compare Standard Report |~

# Jrice~ Mass BBB Qld Diam 1 Mass llo Zlarit 2 m- Gr {
v Import... @ 37628

v ® 7187% 1.7860 BB 4 47.31% Briliant 1.4744 VS1 H EX

| ) £ | <D o] |y

w Solution Info
SOLUTION DIAMOMDS PRICE MASS YIELD (
1 [ 2 7187.05 5| 1.78 ct |47.31 %| 0.12 ct

w Diamonds B Adjust columns X
Diam# =  Cut Price  Jiscour PPC Mass Clarity € 3rad

V| Diam 1 Briliant  6784% 4615.00%/ ct ctVS1 H EX Solution columns: Diamonds colurmnns:

v| @ Diam2 Briliant 403% -35% 1300.00%/ct 0.31ct VS1 H EX ¥| Show/hide model or solution | Cutting

# (Model Mame / Solution Mumber) v Model Color
v Label Color v Mass (Model Mass)
¥ | Clarity Status ¥ Allec (Allocation Algorithm)
» Inclusions | Price ¥ Clarity
. . - v Mass (Model Mass) v DZ (Diamond Color)
» Active Appraiser and Pricelist 7 BBB v Sym-O (Optical Symmetry)
¥ Yield ¥ Gr (Final Grade)
Select algorithm and diamonds for allocation. v/ Cut (Cut Grade)
Algorithm 06. Semicut (final) ~ V| Sym (Symmetry Grade)
Cutting list grade of 1st diam: ¥ Br (Brightness metric)
Brilliant - EX - # (Model Mame / Solution Mumber)
Clarity Status
Brilliant
@ Drag & Drop items to rearrange columns
Reset columns set to defaults
- -

Run  Diamond Results Also save sorting order

0Ok Cancel
To restore the default set of columns in the default order, click Reset columns set to defaults.
Besides setting the column set, you may also save sorting order you currently use (the Also save sorting order option).
Also save sorting order
Selected Not Selected
Sorting you use when closing the current project will be used for the next project you open. For the next project you open, its own saved sorting will be used.

Note Once selected, the option stays active in spite of restarting the program or opening the next projects. = Notes

® The sorting for the project is saved (or updated) when you apply File > Save operation to the project itself.
® As soon as you deselect the option, the project immediately switches to its own sorting.

Generating Reports - New Paths and Naming

For some reports, the paths for storing generated report files and file naming has been changed:



il = | OctoNus Software

Home Share View
» U & cut x EE I New item ~ '+ Open = [ select an
w-| Copy path « ﬂ Easy access ¥ | Edit o0 Select none
Pinto Quick Copy Paste = Move Copy Delete Rename Mew Properties
access EI Paste shortcut to - to- - folder - &) History EJE'In\rert selection
Clipboard Organize New Open Select
“ v " 3 ThisPC s Documents + OctoNus Software »
MName Date modified Type Size
7 Quick access
3 Comparative Reports 22,03.2019 13:41 File folder
[ Desktop - = .
Custom Reports 27.02.2019 11:51 File folder
¥ Downloads  # Export Reports 13.03.2019 17:27 File folder
Documents 4 ™ pported Models 18.11.2016 15:30 File folder
5 Dropbox (OctoM # it Faceting Reports 06.03.2019 13:07 File folder
[&=] Pictures - ** Facetware Reports 05.04.2019 12:47 File folder
* 13D Reports 27.02.2019 12:00 File folder
22 Dropbox (OcteM
&* Dropbox (Octolus) * Polish Reports 26.02.2019 16:23 File folder
@ OneDrive % Rough Reports 14.02.2019 17:42 File folder
& ThispC
_J 3D Objects -
J ! Affected repors
[ Desktop

Documents

The new paths and file names are the following:

RTF XXXX-Project Name-report.rtf
A Documents OctoNus Software Report Folder XXXX-Project Name

HTML HTML and related files

Legend

. XXXX - sequence number

Comparative Reports. Now when you click on the right panel, the Comparative Report, then, in the Select template section, click the Open RTF tab, select the template and run the report, the generated RTF file will be automatically saved as:
..\Documents\OctoNus Software\Comparative Reports\RTF\Project Name\XXXX-Project Name \ XXXX-Project Name-report.rtf
For example, if you run comparative report 3 times for the "Demolct.oxgz", you will obtain:

| = | Demolct

Home Share WView
“ v g s This PC » Documents » OctoMus Software » Comparative Reports » RTF » Demolct » v O
-~ Name Date modified Type Size
# Quick access
0001-Demolct — 05.04.2019 16:52 File folder
[ Desktop + .
0002-Demolct 05.04.2019 16:52 File folder
¥ Downloads * 0003-Demolct 05.04.2018 16:52 File folder
Decuments -
[&=] Pictures Mame Date modified Type Size
Bashurov 0001-Demolct-report 05.04.201% 16:51 Rich Text Format 514 KB
MyRound Appraiser - Improved Furetit

Facetware Reports. Now when you click on the right panel, the Facetware, and obtain the Facetware report in the HP Oxygen interface, then click the Export to MS Word button, the generated RTF file will be automatically saved as:
...\Documents\OctoNus Software\Facetware Reports\RTF\Project Name\XXXX-Project Name \ XXXX-Project Name-report.rtf
For example, if you run Facetware Export to MS Word 3 times for the "Demolct.oxgz", you will obtain:



| = | Demolct

Home Share View
« v » ThisPC » Documents » OctoMNus Software » Facetware Reports » RTF » Demolct » v O
2 Name - Date modified Type Size
7 Quick access
0001-Demaolet — 05.04.2019 16:52 File folder
[ Desktop -
0002-Demolct 05.04.2019 16:52 File folder
¥ Downloads * 0003-DemoTct 05.04.2019 16:52 File folder
Decuments -
[&=] Pictures Mame Date modified Type Size
Bashurov 0001-Demolct-report 05.04.2019 16:51 Rich Text Format 514 KB
MyRound Appraiser - Improved Furetit
Polish Reports. Now when you click on the right panel, the Polish Report, then, in the Report templates section,
® click the Open RTF tab, select the template and run the report, the generated RTF file will be automatically saved as:
..\Documents\OctoNus Software\Polish Reports\RTF\Project Name\XXXX-Project Name \ XXXX-Project Name-report.rtf
For example, if you run Polish report 3 times for the "Demolct.oxgz", you will obtain:
| = | Demolct
Home Share WView
<« v » ThisPC » Documents » OctoMus Software » Polish Reports » RTF » Demolct » v D
-~ Name Date modified Type Size
#F Quick access
0001-Demaolet — 05.04.2019 16:52 File folder
[ Desktop +
0002-Demolct 05.04.2019 16:52 File folder
¥ Downloads . 0003-Demolct 050420191652 File folder
Documents -
[&=] Pictures Mame Date modified Type Size
Bashurov 0001-Demolct-report 05.04.201% 16:51 Rich Text Format 514 KB
MyRound Appraiser - Improved Furetit
® |f you select the Open HTML tab:
...\Documents\OctoNus Software\Polish Reports\HTML\Project Name\XXXX-Project Name \files of the report .
| = | Demolct
Home share Wiew
« v 4 > ThisPC » Documents » OctoMus Software > Polish Reports » HTML » Demolct »
4 Downloads A " Name Date modified Type Size
Documents * 0001-Demalct — 05.0420191%08  File folder
&= Pictures -
Bashurov
MyRound 4 Mame Date Type Size
Output g all 05.04.2017 18&:06 Cascading Style 5... 128 KB
Smart Recd all.min 05.04.2017 18&:06 JavaScript File 113 KB
CULET_CENTER_CROSS 27.03.2017 13:50 PNG File 1KB
** Dropbox (0 @ pernotct-report 05.04.2019 12:08 Chrome HTML De... 50 KB
22 Dropbox (Pe DIAMETER_REPORT_COLOR 05.04.2019 18:08 PNG File 202 KB
DIAMOMND_PICTURE_REFRACT_COLOR 05.04.2019 18:08 PNG File 22 KB
& OneDrive GIRDLE_CEMTER_CROSS 27.03.2017 13:50 PMG File 1KB
Attachmen GIRDLE_CEMTER_MASS_CROSS 27.03.2017 13:50 PNG File S5KB
Document POLISH_ANGLES_REPORT_CRM_AMNGLES 05.04.2019 18:08 PNG File 49 KB
Flow POLISH_AMGLES_REPORT_PAY_AMGLES 05.04.2019 18:08 PNG File 48 KB
MOSQIT SIMPLE_REPORT_COLOR 05.04.2019 18:08 PNG File 25KB
TABLE_CENTER_CROSS 27.03.2017 13:50 PNG File 2KB
Motebooks
OctoMus
WRK Frnratinn

Scene Model and Photos View - Show Grid Option




Now for the Scene in Model or Photos view, you can show the grid. To enable the grid, set Scene to the Model or Photos view, then from the main menu, select View > Show Grid. To disable the grid, clear the Show Grid checkbox. As you zoom in/out, the grid step and units (mkm, mm) adjust to the current zoom level.

54

B File Edit View Inclusion Window Settings Help

S A O e 2 D2 GL G2

incluzions 3
Scan Recut  diamends inpolished Photoreal developer  colors

x

~ Models E
Shadow scan 0 03358 4724
Refined scan 2 0 03354 4724
Refined scan 3 0 03349 +7.24

Il Crown Reflect scan 4 0.3357  +7.35
4 »

« Edit Model Edges
X |[dald)| s | D | &

+ Cutting & Method

"' “‘ -
‘m a4

Brilliant Oval Marquise
;;; m:m @ > |w
~ Scan & Buid
Stone ID:
Hardware not connected
Print Save Report
Rebuid Refine Pavilion Refine Crown
Advanced ~

With the grid enabled, you can click . to display

H oo

Pl ey mm | e B e o

- View
KX

I3D Mini View

Compa 13D Mini View

v Photos
Crown Collage
Facetware
Standard Report
My Appraiser
* Reports

+ Maodel Buiding Info
Method: Unknown

Reflect: small errors
Avg (Std) 2.6 Max (Lin) 14.4
Class Type Emor # =

Shadow Std dev 8.1 210
Shadow Std dev 7.7 129
Shadow Stddev 7.1 23
Shadow Stddev 7.0 43
Shadow Lindev 10.7 23+
| Show Model

and horizontal measurements (mm) of the projection of the displayed model in its current position.



Click E again to hide measurements

Input Stone Properties - Changes in Dialog

During scanning, on clicking the Shadow scan button, the Input Stone Properties dialog may be displayed.

@ Detailed information about inputting stone properties on the start of scanning is presented on the Entering Stone ID and Measured Weight page.

In the Input Stone Properties dialog, you can use the Next i button or press Ctrl+Tab to increases the stone number by 1 and changes the scan number to 001.

To avoid pressing Ctrl+Tab by mistake, the following changes have been implemented for this dialog:

® The hint text for keyboard shortcut CTRL-TAB has been changed:
© Was : "Use Ctrl+Tab shortcut to increment Stone ID"
© Now : "If you need to increment Stone ID, use Ctrl+Tab shortcut”
® The hint:
© Was : always displayed
© Now : hidden when the Automatically generate default Stone ID for new scans option is selected.

@ Only the hint is hidden - the Ctrl-Tab combination still can be used.


https://octonus-teams.com/wiki/display/HPODPUB/Entering+Stone+ID+and+Measured+Weight
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Fixed Problems and Improvements

The following fixes for the known problems and improvements have been implemented:

1. The model building has been improved by the additional tuning of the facets blocking mechanism, which decreases the possibility of the wrong removal of the large parts of the stone.
2. One of the main facets was split, which was caused by the contour erroneously excluded from the calculation. This model building error has been fixed.

blocked URL
. Girdle additional facets classified as dust error has been fixed.
. Fixed rare program crash from orphaned Smart Recut calculations finished on a closed or a new document.
. Failure on export of the Facetware report has been fixed.
In the Comparative Report and Comparative 13D Mini View:
a. the accuracy of facets mapping is increased, the number of facets mapped by mistake is reduced;
b. some rare position fitting bugs have been fixed.
. Sometimes MyRound allocation of Brilliant cut produced VG plans with "GirdleValley" parameter out of EX range (this might happen for plans with non-standard upper/lower girdle facets azimuth). Now, this issue is fixed and GirdleValley limitations are correctly considered during the allocation process.
. For the Model Topology Editing Tool, the bug with the unexpected multiple edges appearance instead of edge deleting has been fixed.
. The problem with automatic actions for Square Radiant also running actions for Radiant has been fixed.
. The recognition error with the shift up sign when using the shift corrector has been fixed.
. The problem with the program unexpected close on opening some .0oxgz files of semipolished stones has been fixed.
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